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INTRODUCTION

What  This  Manual  Is

This is the PC-MICAR System Manager's Manual. PC-MICAR is a cause-of-death data
entry system designed for editing and processing of medical information reported on a
death certificate in the United States. PC-MICAR requires a trained MICAR coder to use!

PC-MICAR is one part of the National Center for Health Statistics’ Mortality Medical
Data System. NCHS began developing the system in 1967 to automate the entry,
classification, and retrieval of cause-of-death information reported on death certificates.
Mortality medical data is processed through four basic programs: PC-MICAR, MICAR1,
ACME2, and TRANSAX3.

• PC-MICAR Automates MICAR data entry and medical cause-of-death data processing,
including reporting procedures, full-screen data entry and editing. PC-
MICAR is designed to assist MICAR data entry operators in encoding
medical cause-of-death data into numeric entity reference numbers (ERNs)
in accordance with the rules expressed in Part 2g of the Vital Statistics
Instruction Manual (VSIM) series. PC-MICAR output is used by later
programs to classify causes of death to their International Classification of
Disease (ICD) codes. PC-MICAR only runs on personal computers.

• MICAR Automates the multiple cause coding rules (see Parts 2b and 2e of the
VSIM series) and assigns ICD codes to each entity.

• ACME Applies World Health Organization (WHO) rules to the ICD codes
determined by MICAR and selects an underlying cause of death (see Part
2a and 2c of the VSIM series). ACME is available on both the mainframe
and the personal computer. On the PC, ACME and TRANSAX are
distributed as a single product.

                    

     1 Mortality Medical Indexing, Classification, and Retrieval

     2 Automated Classification of Medical Entities

     3 TRANSlation of AXis
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• TRANSAX Facilitates the tabulation and use of multiple cause-of-death data. Through
the application of the ICD linkage and modification rules, TRANSAX
translates the axis of classification from an entity to a record base.
TRANSAX is available on both the mainframe and the personal computer.

The only other manual specifically associated with this one is the PC-MICAR User's
Manual. The User's Manual contains information on the installation and maintenance of
the PC-MICAR software, as well as some utilities that may need to be used.

Who  This  Manual  Is  For

This manual is intended for the System Manager. It contains instructions on using those
functions of PC-MICAR necessary to the overall data entry process, as well as installation
and file management information. By necessity, some sections of this manual will overlap
the PC-MICAR User's Manual. However, the PC-MICAR System Manager's Manual
contains instructions for those Menu Options and Functions not covered in the PC-MICAR
User's Manual. These additional functions of PC-MICAR will prove useful in helping the
System Manager make data entry and processing run smoothly.

Changes  in  1996

The 1996 version of PC-MICAR data entry software includes numerous changes from the
1995 and other previous versions. Many of the changes are easily apparent, and others
might go almost unnoticed. This section outlines the differences, so that you can quickly
familiarize yourself with them. For a graphical overview of the changes, a demonstration
of many of them has been provided on the installation diskettes. Refer to the installation
instructions for information on installing and running the PC-MICAR Data Entry 1996
demo.

The File System

The most fundamental difference in the 1996 version lies in how it handles files. In the
past, each file would contain a single batch of work, and each file could be either open or
closed. The open file was the one you were currently using. Closed files were stored in a
compressed format in the <BATCHES> directory. In 1996, the file format is changed.
Your batches are stored in a <DATA> subdirectory that you can specify through the
program. This directory can be on a network drive (See Network Compatibility, below).
Any file that exists in your data directory can be opened at any time. Thus, closing a
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batch does not include compressing it or moving it to another location. It merely closes
that file and allows you to open another one, or create a new one.

Files are also stored in a different database format. The new database files use a
Foxpro-compatible X-base database. Data files from previous versions of PC-MICAR
cannot be used by the new system, but can be converted by exporting the MICAR100
input file (the mainframe file) from the 1995 version and importing it into PC-MICAR
1996 using the Import MICAR 100 File option from the File menu. However, because of
changes in the 1996 external cause prompts, it is not advised to process data entered
through a prior system.

In addition, the enire MICAR data structure for all PC-based MICAR software
(Super-MICAR, PC-MICAR Data Entry, MICAR100/200, and PC-ACME/TRANSAX) has
been universalized. The data file that PC-MICAR creates contains provisions for storing
the data from all MICAR programs. Thus, you no longer need to generate a MICAR100
(mainframe) input file unless you are uploading to a mainframe for MICAR processing.
The PC versions of MICAR100 can read the same data file format that PC-MICAR uses,
as can PC-ACME/TRANSAX. For more information on data sharing between the
PC-based MICAR systems, see the section The Unified Database later in this manual.

Network Compatability

The new file system includes provisions for accessing data on network file servers. With
this ability, you can keep your files on a local area network, where they can be available
to multiple users at all times. As a part of this compatability, each file is also multi-user
accessible. With this ability, multiple users can enter data into the same file
simultaneously. It is still recommended, however, that bacthes be kept small in order to
facilitate storing, shipping, and finding the proper files and records. By combining
network-compatible files, multi-user access, and muiltiple file availability, it is possible in
the new system to segment data in new ways. For example, it is possible to have one file
for each month, and enter all deaths for that month into a single file on a network drive. 

The Menu System

The most apparant change in PC-MICAR 1996 is the change from the menu list that was
used in earlier versions to the drop-down menu interface that is in the 1996 version. The
drop-down menus are easier to use, easier to naviagte, and place all the options of
PC-MICAR at the user's fingertips. The PC-MICAR 1996 Demo is primarily geared to
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showing the menu system and how to access its functions. For more information on the
menu system, go through the demo, or read the section "Using the Menus" in this manual.

The Universal External Cause Prompts

PC-MICAR 1996 is the first system to collect and use the ICD9/ICD10 Universal Prompts
for External Causes. These are equivalent to the external cause prompts used in earlier
versions of PC-MICAR, but have been revised to make it possible to collect data for both
the 9th and 10th revisions of the International Classification of Disease. MICAR data
entry coders should familiarize themselves with the new prompts. These prompts are
provided in a PDF format with the installation disks, and will also be printed in the 1996
revision of the MICAR Instruction Manual Part 2g. There is a practice package included
with the installation disks, called Prompt10, to help coders become familiar with the
changes. Instructions for installing the Prompt10 package are in Installing PC-MICAR,
later in this manual.Instrctions for running the Prompt10 package are in Appendix E,
Accessing the Universal Prompt Demo.

The Spelling Checker

In previous versions of PC-MICAR, terms that did not match the dictionary were brought
to the user's attention for correction. These were done on a causal basis. That is, if the
cause was not found in the dicionary, a warning was given and the user could select from
a list of potenial causes. In PC-MICAR 1996, the dictionary match program looks for
erros on a word-by-word basis. That is, each misspelled word in the term is matched
individually, and the list of suggested corrections is a list of properly-spelled words. If all
the words are spelled correctly and the term does not match, this also generates a warning
message.

Reporting Area

The Reporting Area field that appeard on the batch information screen has been removed.
This data is no longer collected.

Coder Status

At the request of several states, the valid values for this field have been expanded to allow
entry of single-digit numbers 0 through 9. 
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Place of Injury

The options for this field have been expanded to accomodate new categories required by
the Tenth Revision of the ICD. To assist in learning and selecting the new codes, a
pop-up menu has been provided, which can be accessed by entering a question mark in
the place of injury field. For a complete list of the places, refer to the 1996 version of the
2g manual.

Activity Code

A new field, Activity Code, has been added. This new field collects information about the
decedent's activity at the time of death. A pop-up menu of options is available by entering
a question mark in the field. For a complete list of the activity codes, refer to the 1996
version of the 2g manual.

Backup/Remove Option

This new option backs up the open file to a floppy disk, then, if the backup is successful,
deletes the file from your hard drive.

Backup Directory and MICAR100 Output Directory

These new options allow you to specify a subdirectory in which to store backup files and
place MICAR100 input files, respectively.
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INSTALLING PC-MICAR

The installation disks provided with this shipment of PC-MICAR contain the PC-MICAR
files in a compressed format. The files cannot be simply copied from the disks to your
hard drive. PC-MICAR must be installed on the computer's hard drive in order to
function. It cannot be run from a floppy disk. 

System  Requirements

PC-MICAR is a DOS program and should only be installed on a personal computer that
meets the following minimum requirements:

• IBM PC or PC compatible computer
• 80386 33 MHz CPU or better
• 640 Kilobytes RAM (see Memory Requirements below)
• Hard Drive with sufficient available free storage space (see Memory Requirements

below)
• Monochrome monitor (color recommended)
• 1 3.5" floppy drive (for 1.44 Mb disks)
• DOS 3.3 or higher (DOS 5.0 or higher recommended)

Memory  Requirements

PC-MICAR requires 470 Kilobytes (470K) of available RAM at the time the program is
started. Video drivers, network drivers, mainframe access software, and other "terminate
and stay resident" (TSR) programs can take up system RAM so that less than 470K of
memory are available when PC-MICAR is started. On systems with DOS 5.0 or greater,
use the MEM command from the DOS prompt to display the amount of available RAM
on the system where PC-MICAR will be installed. With earlier versions of DOS, use the
CHKDSK command to list available memory.

To install PC-MICAR, the computer’s hard drive must have 21 Megabytes of free space.
If there is insufficient space to install the software, the installation program will warn the
user and halt the installation.
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List  of  Files  on  the  Installation  Disks

Below is a list of the files on the installation disks provided for the System Manager's
convenience.

INSTALL.EXE The installation program.

INSTALL.CFG The installation configuration.

PKUNZIP.EXE A data de-compression program.

DISKx.ZIP The file containing the compressed PC-MICAR files that will be
put into the <PCMICAR> directory. Each installation disk will have
a DISKx.ZIP file, where 'x' is the number of the installation disk.
(Example: DISK2.ZIP will be on Installation Disk #2.)

List  of  PC-MICAR  Files

Below is a list of the files that will be installed by the PC-MICAR installation program.
By default, PC-MICAR is installed in a directory that is named <PCMICAR>. This
default can be changed during installation. Two other directories will be created as
subdirectories to the <PCMICAR> directory: these are <DATA> and <TABLES>. The
<DATA> directory contains all of the data files created by PC-MICAR. The <TABLES>
directory contains all of the tables that PC-MICAR uses in processing and spell-checking. 

Please note that there are two sets of files. The first set, the data entry files, will always
be installed. The second set, the processing files, will be installed only if the System
Manager tells the installation program to do so.

Processing/Data  Entry  Files

These files are necessary for data entry.

BBDxx.HSH The BBDxx.HSH files contain an entity reference number
dictionary for over 121,000 medical causes of death. These are used
during processing to look up entity reference numbers. The
BBDxx.HSH files look up text to find a matching ERN. This file is
installed in the <TABLES> directory.
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ERNxx.HSH An index to the entity reference numbers (ERN) that takes an ERN
and returns the associated cause of death. This file is installed in
the <TABLES> directory.

EXTERN10.DAT A textual definition of the External Cause prompts. This file is read
to create the menus and selections taken from the External Cause
prompts. This file is installed in the <TABLES> directory.

LEXICON.CFG A spell-checker configuration file for all of the LEXICON.* files.
Contains information on LEXICON.DAT and LEXICON.HSH to
tell PC-MICAR how to use these files.

LEXICON.DAT A spell-checker file containing a list of words for use with PC-
MICAR's spell-checking features.

LEXICON.HSH A spell-checker file containing an index to the words in
LEXICON.DAT.

MICAR.CFG A configuration file for all hash tables (MICAR.HSH, BBDxx.HSH,
EXTERNS.HSH, ERNxx.HSH, SNX.HSH, SNXINDEX.HSH).
Contains information on hash file contents. Without this file, none
of the hash tables will open and operate correctly. This file is
installed in the <TABLES> directory.

MICAR1.HSH A hash indexed file containing spellings and definitions for 8000+
medical terms. Used as a spell-checker during data entry and for
word definitions during processing. This file is installed in the
<TABLES> directory.

PKUNZIP.EXE A utility that de-compresses files that were archived using PKZIP.
This is called during database restores. This file is installed in the
<PCMICAR> directory.

PKZIP.EXE A utility that compresses files into smaller ZIP-formatted files. This
file is installed in the <PCMICAR> directory. This is called during
database backups.

PCEDIT.HLP The HELP file for the certificate editing screen. This file is
installed in the <PCMICAR> directory.
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PCM96CVT.EXE A utility program that converts PC-MICAR database file created
with the October, 1995 version of PC-MICAR 1996 to the proper
format for use with the January, 1996 version of PC-MICAR. For
more information on database conversion, see Appendix G,
Converting Files. This utility is installed in the <DATA> directory.

PCMICAR.EXE The PC-MICAR executable program. This file is installed in the
<PCMICAR> directory.

PCMICAR.HLP The HELP file text. This file is installed in the <PCMICAR>
directory.

STATES.TXT A file listing information about the states/province in a country. A
list of US states is provided. Any other English speaking country
can use PC-MICAR and replace the state list with any ASCII file
editor. The format is:

Column Item
1-2 2 character abbreviation
3-4 2 digit numeric code
5-24 20 character state/province name

Database  Files

The following files are PC-MICAR database files. They will be generated by PC-MICAR.
The term "filename" is the name of a database file. Database filenames are supplied by the
user when the file is created (see Creating a New Certificate File in the PC-MICAR
User’s Manual). Database file names are restricted to seven characters in length. (The
eighth character is used by PC-MICAR for identification of specific file types.) All of
these files will be stored in the <DATA> directory.

filename.CDX An index to the database file.

filename.DBF A file containing certificate data.

filename.FPT A file containing portions of the certificate data that are ususally
not filled with information, such as the injury block lines and lines
11-20 of the cause of death data.

filename.HDR A file containing header information for the database file. This
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information is the same for every record in the file.

filename.PBK A backup file created by using the Backup All Files or Backup and
Remove Function. This file contains a compressed copy of all of
the files associated with a particular batch of certificates.

ssyylll.ZIP A backup file created by the Backup for NCHS Function. ss = state
code, yy = year, lll = lot number.

Report  Files

Listed below are PC-MICAR files that contain reports created by PC-MICAR:

filename.SSQ A report file of missing certificates in the database. Created by the
Sequence Check Function (see Generating a Sequence Check in the
PC-MICAR User’s Manual).

filename.1IN A MICAR100 Input file created by PC-MICAR processing.

File  Naming  Conventions

As mentioned above, PC-MICAR certificate database files can be given any name of up to
seven characters. For consistency, however, it is recommended that each state use a file
naming convention that allows the system manager to easily identify each file by its name.
NCHS uses a file name convention in which each file is identified by its state
abbreviation, lot number, data year, and coder status. Thus, each filename would look like
this:

SSYYNNN.xxx, where

SS is the state abbreviation.
YY is the year
NNN is the lot number.
.xxx is the file extension that identifies each type of file, as indicated above.

Thus, the file for Alabama, lot 412, in year 1993, by the initial coder would have the
name AL93412.SIN. While the states are free to use any file naming convention they
desire, the file name convention described above is used to name the backup file when
backing up a batch for shipment to NCHS. 
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Installation  Instructions

PC-MICAR is very easy to install. Simply follow the directions listed below. NOTE: If
PC-MICAR is being re-installed, the old files will be overwritten.

IMPORTANT: The files on the disk are in a compressed format. PC-MICAR cannot be
run from the installation disks. These files MUST be installed using the INSTALL.EXE
program on Disk #1.

1. Place Installation Disk #1 in a disk drive.

2. Switch to the drive containing Installation Disk #1. This can be done by typing the
letter of the drive with a semicolon, and pressing {ENTER} at the DOS prompt.
(Example: Type A: {ENTER} to switch to the A drive.)

3. Type INSTALL and press {ENTER}.

4. The Installation Configuration window will appear (see Figure 1). Make any
changes to the data displayed as necessary. The various fields are explained below.

SOURCE DRIVE The drive containing the Installation Diskette (usually
drive A or drive B).

DESTINATION PATH The hard drive on the PC (usually hard drive C or hard

Figure 1:The Installation Configuration window with sample entries.

                                                             
  INSTALLATION PROGRAM CONFIGURATION  
                                                             
   
  SOURCE DRIVE....: B  
   
  DESTINATION PATH: C:\PCMICAR  
   
  Change these values or Begin installation (C, B, ESC): B  
   
                                                             

drive D) and directory that will contain the PC-MICAR
files.
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Change these values... Pressing the following keys will have the listed effects:

{C} Allows the System Manager to change the SOURCE DRIVE and
DESTINATION PATH.

{B} Begins the installation process. See step 5 below.

{ESC} Ends the installation process and returns to DOS.

5. When the installation program has been told to install (by pressing "B") the
processing files, a window will be displayed in which to select the options to
install. By selecting YES or NO, the PC-MICAR 1996 demo and the Universal
Prompts demo can be installed.

6. Once the installation options are selected, a window will be displayed showing the
files being installed. A progress bar will also be displayed at the top of the screen
showing what percentage of PC-MICAR has been installed. Whenever a new disk
needs to be put in, an instruction window will appear, telling which disk number
needs to be inserted into the disk drive.

7. After the installation is complete, an "Installation Complete" message window will
be displayed. Press any key to return to DOS. PC-MICAR has now been installed.
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OVERVIEW

Basic  Steps

PC-MICAR is designed to allow both data entry and data processing through the menu
system. When collecting and processing data through PC-MICAR, certain steps should be
followed in order to guarantee the best results with the least wasted time. What follows is
a general outline of the MINIMUM data entry and processing steps for PC-MICAR. PC-
MICAR contains several utilities and reports that are helpful in validating data and
keeping track of data entry and processing. Utilities are described in the next section, with
indications of where they would be most useful. 

Note that the relevant sections of this manual are listed next to each step (the sections
without page numbers are from the PC-MICAR User's Manual).

1. Start PC-MICAR (STARTING PC-MICAR).

2. Open a certificate file (Opening an Existing File). This step opens a file so that
data can be entered and processed. You can either open an existing file or create a
new file. With very few exceptions, every function that PC-MICAR can perform
requires that a file be opened before the function can be preformed.

3. Edit the certificate file header information as needed (Creating a New Certificate
File). The header information contains constant data that is the same for every
record in the certificate file, such as the data year and the state code.

4. Add certificates to the database (ENTERING AND SAVING CERTIFICATE
DATA). This is the main data entry process. PC-MICAR's editing functions may
prove useful in this step (see EDITING FUNCTIONS).

5. Process the certificate file (PROCESSING A CERTIFICATE FILE). When a file is
processed, PC-MICAR assigns entity reference numbers (ERNs) to the medical
causes of death that were listed in the certificate file. This step is only necessary if
the dictionary was turned off during data entry.

6. Generate MICAR100 file (GENERATING A MICAR100 FILE). This file is used
by other MICAR software to continue the process of encoding cause-of-death
data.This step need not be taken if the data is going to be processed by the PC
versions of MICAR100 and 200.
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7. Create a backup for shipment to NCHS (Creating Backups for NCHS). This
function creates a file that can be shipped to NCHS. The file contains the
MICAR100 file generated in the previous step.

8. Close the certificates file (CLOSING A FILE).

9. If there are other certificate files to process, repeat steps 2 through 7.

10. If there are no more files to process, exit PC-MICAR and return to DOS
(EXITING PC-MICAR).

PC-MICAR  Utilities

Below are listed additional Functions that PC-MICAR can perform. Most of these utilities
can be used at any time with PC-MICAR. Most will require that a certificate file be open.
See the individual description of each utility for more details.

1. Browse through and edit the certificates in a file (Browsing Through the
Certificates). This function allows the user to edit information in the certificate
database, which may be necessary at any time.

2. Find a specific certificate number/record in a file (Finding a Record). This function
is available only when browsing through the certificates and allows the user to
display a particular record by specifying its certificate number.

5. Delete a certificate while editing (Deleting Certificates While Editing a Certificate
File). This function allows the user to remove a record from the certificate file.

6. Delete several certificates at once (Deleting Several Certificates at Once). This
function allows the user to remove a block of several records from the certificate
file. Use this option if an error has occurred and several certificates have been
entered into the wrong file.

7. Generate a sequence check (Generating a Sequence Check). This function generates
a report that checks the sequence of the certificate numbers in the file. It is useful
in determining if all of the records that should be in the file have been entered, if
unwanted records have been entered, or if records have been entered with an
incorrect certificate number. This function can be used at any time, but is most
useful between data entry and processing to determine if the file is complete.
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8. Print all or selected certificates for review. See Printing All the Certificates and/or
Printing a Single Certificate.

9. Perform a daily backup. (Backing Up All the Files). This function creates a backup
copy of the open certificate file either on your system's fixed drive or on a floppy.
Backing up data is the only protection available against losing data due to a failed
computer system. It is a good idea to back up the certificate file at the end of every
day.

System  Manager  Functions

The following functions may require additional technical knowledge and should only be
accessed by the System Manager:

1. Repair File Index (REPAIRING A FILE INDEX, pg. 19).

2. Restore from Backup and Backup and Remove (BACKUPS AND RESTORES, pg.
20, 24).

3. Set Data File Path (SET DATA FILE PATH, pg.22).

4. Set Table File Path (SET TABLE FILE PATH, pg. 23).

5. Set Backup File Path (SET BACKUP FILE PATH, pg. 24).

6. Set MICAR100 Export Path (SET MICAR100 EXPORT PATH, pg. 25). 

7. Access the DOS Prompt (GETTING TO A DOS PROMPT, pg. 26).
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Using the PC-MICAR Menu System

PC-MICAR Functions are available through a drop-down menu system. The menu system
allows the user to quickly select Functions to perform and to move from task to task
quickly and easily. Unlike the menu lists available through other types of software, PC-
MICAR uses a menu system that allows an option to be selected from the menu even
when another function is active. This allows users to select Functions more quickly,
without having to exit their way 'back up the tree' before they can select another function.

There are two ways to access the menu: 

Figure 2: The Edit Menu Option and its Functions.

PC-MICAR: TEST1.DBF
 File Edit Process Reports Backup Help

                                          
  Edit Header Info   
  Add Certificates F3   
  Browse Certificates F4   
  Delete Records F8   
  Find a Record F5   
  Print a Record F7   
  Turn Dictionary On/Off F10   
  Undo Changes ALT-U   
                                          

                       F1-Help 2 58pm

ALT-X : Simultaneously pressing the {ALT} key and the highlighted letter key of a
main menu item will display the drop-down menu for that item. (The Alt
keys for each menu option are listed in Table 1.) Then use the up and
down arrow keys to highlight an item on the menu. Press {ENTER} to
select the option. Use the left and right arrow keys to open submenus for
other main menu options. Pressing {ESC} from a dropped-down menu
closes the menu. Pressing {ESC} from the main menu will exit PC-
MICAR.

HotKey: Many of the functions in the menus have an associated hotkey. The hotkey
assignments are shown on the drop-down menus and are listed in Table 2.
Pressing a hotkey will immediately access the associated function. (For
example, pressing {F2} will select the Open Existing File function.)
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Hotkeys are the fastest, easiest way to move around PC-MICAR. As users
become familiar with PC-MICAR, they will find the hotkeys easier to use. 

To select a Function from a drop-down menu, either use the up and down arrow keys to
highlight an option or press the option's selection letter. The selection letter is displayed in
red (on color monitors) or highlighted (on monochrome monitors). Pressing the selection
letter will move the highlight bar to the selected option. 

Figure 2 gives an example of the Edit Menu Option and its Functions.

Not all Functions are available at all times. In order to prevent users from selecting
Functions that should not be accessed during a particular process, the menu system will
make certain Functions available (active) or unavailable (inactive). On color monitors, the
active options are shown in black while inactive options are shown in gray. On
monochrome monitors, inactive options do not have a highlighted selection letter. When
an option is inactive, it cannot be selected (the highlight bar will skip over that item and
its hotkey will not function). 

TABLE 1: PC-MICAR Menu Options

Key Combination Menu Option Accessed 

{ALT-F} File Menu Option

{ALT-E} Edit Menu Option

{ALT-P} Process Menu Option

{ALT-R} Reports Menu Option

{ALT-B} Backup Menu Option

{ALT-H} Help Menu Option
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Table 2: Function Listing

File
{ALT-F2} Create New File
{F2} Open Existing File
{ALT-F4} Close File

Repair File Index
{ALT-F6} Set Data File Path
{SHIFT-F6} Set Table File Path

Set Backup Path
Set MICAR 100 Export Path

{ALT-X} Exit PC-MICAR

Edit
Edit/Browse Header Info

{F3} Add Certificates
{F4} Edit/Browse Certificates
{F8} Delete Records
{F5} Find a Record
{F7} Print a Record
{F10} Turn Dictionary On/Off
{ALT-U} Undo Changes

Process
Process All Records
Generate MICAR100 File

Reports
Sequence Check
Print All Certificates

Backup
{ALT-F7} Backup All Files

Backup for NCHS
{ALT-F8} Restore from Backup

Backup and Remove

Help
{F1} View Help File
{ALT-F1} About PC-MICAR
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REPAIRING A FILE INDEX

Occasionally, the file index may be damaged and need to be repaired. The Repair File
Index Function rebuilds the file index from the data file.

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Repair File Index Function and
press {ENTER}.

3. A window will be displayed while the index is being rebuilt.

4. When the file index has been completely rebuilt, the main screen will be re-
displayed.
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BACKUPS AND RESTORES

Taking  Backups

PC-MICAR uses PKZIP to compress data put into backup files. There are three types of
backup files used by PC-MICAR. Backup All Files creates a backup of a certificate file
(plus its associated files) and stores it in a file called [filename].PBK. The second type of
backup, Backup for NCHS, does the same thing and creates a backup file called
[filename].ZIP. The third type creates a backup (called [filename].PBK) and then gives the
user the option to delete the database file from the hard drive. ALL of these files are
compressed using PKZIP.

Backup All Files and Backup for NCHS are described in the PC-MICAR User’s Manual.
The Backup and Remove Function is described below:

Backup  and  Remove

This Function is used to create a backup of a certificate file. It also removes the file(s)
from the hard drive.

1. Press {ALT-B} to select the Backup Menu Option.

2. Use the up and down arrow keys to highlight the Backup and Remove Function.
Press {ENTER}.

3 A window will be displayed requesting a drive letter to send the backup to. Press
the letter of the drive ('A' for the A: drive, 'B' for the B: drive, etc).

4. A message window will be displayed while the backup is being made.

5. When the backup is finished, another window will appear.

A. To delete the certificate file and all of its associated files from the hard drive,
press {Y} for YES.

B. To abort deleting the files, press {N} for NO.

6. The main screen will be re-displayed.
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Restoring  From  a  Certificate  File  Backup

Below are instructions on restoring from a certificate backup made using either Backup
All Files or Backup for NCHS (see CREATING BACKUPS in the PC-MICAR User’s
Manual). Note that if there is an open file, it must be closed.

1. Press {ALT-B} to select the Backup Menu Option.

2. Use the up and down arrow keys to highlight the Restore From Backup Function.
Press {ENTER}.

3. A file selection window will be displayed. Use the {TAB} and arrow keys to move
the cursor between fields and select the drive, directory, and file to restore from.
When the desired file is highlighted, press {ENTER}.

4. A window will be displayed saying that the restore is in progress.

5. When the restore is finished, the restored file will be open and ready for use.

6. The main screen will be re-displayed.
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SET DATA FILE PATH

The data file path tells PC-MICAR where the certificate data files are located on the hard
drive. The data path will need to be changed if the data files are put in a different
directory. This menu option will become available only when no data file is open.

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Set Data File Path Function and
press {ENTER}.

3. A data file path window (see Figure 3) will be displayed.

Figure 3: The Set Data Path window.

                                                                 
  Enter Data Path  
                                                                 
 Enter path: C:\PCMICAR\DATA\  
   
                                                                 

4. Type in the data file path in the following format:

[drive]:[directory]\

Example: C:\PCMICAR\DATA\

5. Press {ENTER}.If an invalid path is given, a message window will be displayed.
Re-enter the path or press the {ESC} key to return to the main screen.

6. If no errors are encountered, the data path will be changed to the new setting and
the main screen will be re-displayed.
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SET TABLE FILE PATH

The table file path tells PC-MICAR where the table files are located on the hard drive.
The table files contain medical entities and entity reference numbers (ERNs) that PC-
MICAR uses during processing.

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Set Table File Path Function and
press {ENTER}.

3. A table file path window (see Figure 4) will be displayed.

Figure 4: The Set Table Path window.

                                                                 
  Enter Table Path  
                                                                 
 Enter path: C:\PCMICAR\TABLES\  
   
                                                                 

4. Type in the table file path in the following format:

[drive]:[directory]\

Example: C:\PCMICAR\TABLE\

5. Press {ENTER}.

A. If an invalid path is given, a message window will be displayed. Re-enter the
path or press the {ESC} key to return to the main screen.

B. If PC-MICAR cannot find the table files on the path, a message window will
be displayed. The table path will be reset to its original setting. The main
screen will be re-displayed.

6. If no errors are encountered, the table path will be changed to the new setting and
the main screen will be re-displayed.
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SET BACKUP PATH

The backup path tells PC-MICAR where to store backed up data. By default, the backup
files are located in the data direcotry. The backup path will need to be changed if the
backup files are put in a different directory.

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Set Backup Path Function and
press {ENTER}.

3. A backup path window (see Figure 5) will be displayed.

Figure 5: The Set Backup Path window.

                                                                 
  Enter Backup Path  
                                                                 
 Enter path: C:\PCMICAR\BACKUP\  
   
                                                                 

4. Type in the backup path in the following format:

[drive]:[directory]\

Example: C:\PCMICAR\BACKUP\

5. Press {ENTER}. If an invalid path is given, a message window will be displayed.
Re-enter the path or press the {ESC} key to return to the main screen.

6. If no errors are encountered, the backup path will be changed to the new setting
and the main screen will be re-displayed.
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SET MICAR100 EXPORT PATH

The MICAR100 export path tells PC-MICAR where to store exported MICAR 100 input
files. (These were referred to as mainframe files in previous versions of PC-MICAR.) By
default, MICAR100 export files are stored in the data directory. The MICAR100 export
path will need to be changed if the files are put in a different directory

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Set MICAR 100 Export Path
Function and press {ENTER}.

3. A MICAR100 path window (see Figure 6) will be displayed.

Figure 6: The Set MICAR 100 Path window.

                                                                 
  Enter MICAR 100 Path  
                                                                 
 Enter path: C:\PCMICAR\DATA\  
   
                                                                 

4. Type in the data file path in the following format:

[drive]:[directory]\

Example: C:\PCMICAR\MIC100\

5. Press {ENTER}. If an invalid path is given, a message window will be displayed.
Re-enter the path or press the {ESC} key to return to the main screen.

6. If no errors are encountered, the data path will be changed to the new setting and
the main screen will be re-displayed.
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GETTING TO A DOS PROMPT

For those situations when the System Manager needs to get to a DOS prompt quickly,
without quitting PC-MICAR, there is a DOS Prompt Function under the File menu option.

1. Return to the main screen.

2. Press {ALT-F} to access the File menu option.

3. Use the up and down arrow keys to highlight the DOS Prompt Function. Press
{ENTER}.

4. This creates a DOS shell. The System Manager can now enter commands through
DOS. When finished, type 'EXIT' and press {ENTER} to return to PC-MICAR.
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APPENDIX A - NCHS STATE CODES

Code State Abbrev.
01 Alabama AL
02 Alaska AK
03 Arizona AZ
04 Arkansas AR
05 California CA
06 Colorado CO
07 Connecticut CT
08 Delaware DE
09 Dist. Columbia DC
10 Florida FL
11 Georgia GA
12 Hawaii HI
13 Idaho ID
14 Illinois IL
15 Indiana IN
16 Iowa IA
17 Kansas KS
18 Kentucky KY
19 Louisiana LA
20 Maine ME
21 Maryland MD
22 Massachusetts MA
23 Michigan MI
24 Minnesota MN
25 Mississippi MS
26 Missouri MO
27 Montana MT

Code State Abbrev.
28 Nebraska NE
29 Nevada NV
30 New Hampshire NH
31 New Jersey NJ
32 New Mexico NM
33 New York NY
34 North Carolina NC
35 North Dakota ND
36 Ohio OH
37 Oklahoma OK
38 Oregon OR
39 Pennsylvania PA
40 Rhode Island RI
41 South Carolina SC
42 South Dakota SD
43 Tennessee TN
44 Texas TX
45 Utah UT
46 Vermont VT
47 Virginia VA
48 Washington WA
49 West Virginia WV
50 Wisconsin WI
51 Wyoming WY
52 Puerto Rico PR
53 Virgin Islands VI
54 Guam GU
55 New York City YC*

* Code 55 is used for occurrence data only. When coding residence data on the demographic
file, code 33 (New York State) must be used.
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APPENDIX B - MENU LISTINGS

PC-MICAR Menu Options

Key Combination Menu Option Accessed 

{ALT-F} File Menu Option

{ALT-E} Edit Menu Option

{ALT-P} Process Menu Option

{ALT-R} Reports Menu Option

{ALT-B} Backup Menu Option

{ALT-H} Help Menu Option
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Function Listing

File
{ALT-F2} Create New File
{F2} Open Existing File
{ALT-F4} Close File

Repair File Index
{ALT-F6} Set Data File Path
{SHIFT-F6} Set Table File Path

Set Backup File Path
Set MICAR 100 Export Path

{ALT-X} Exit PC-MICAR

Edit
Edit/Browse Header Info

{F3} Add Certificates
{F4} Edit/Browse Certificates
{F8} Delete Records
{F5} Find a Record
{F7} Print a Record
{F10} Turn Dictionary On/Off
{ALT-U} Undo Changes

Process
Process All Records
Generate MICAR100 File

Reports
Sequence Check
Print All Certificates

Backup
{ALT-F7} Backup All Files

Backup for NCHS
{ALT-F8} Restore from Backup

Backup and Remove

Help
{F1} View Help File
{ALT-F1} About PC-MICAR
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APPENDIX C - DICTIONARY OF TERMS USED

Since not everyone will be familiar with the terms used in these instructions, here is a
brief glossary of some of the words.

Certificate File - A file containing certificate data. This term is used interchangeably
with Database File.

Data Directory - A subdirectory on the computer where PC-MICAR certificate files
are stored. By default, the data directory is a subdirectory of the
<PCMICAR> directory called <DATA>. The default value can be
changed through PC-MICAR.

Database file - A file containing certificate data. This term is used interchangeably
with Certificate File.

Directory - A specific grouping of files on a disk. Also referred to as a
subdirectory. The directory that will be used most with PC-MICAR
will be the <PCMICAR> directory.

DOS - A Disk Operating System. The System Manager will handle most
operations that deal with DOS. The only time the data entry
personnel will use DOS will be in the STARTING PC-MICAR
section of this manual.

Export - To take data from the PC-MICAR certificate database and place it
in a formatted file that is readable by other programs.

Extension - A 3-letter identifier at the end of a filename that identifies what
type of file it is. For example: .EXE is an executable file, .DBF is a
database file, and so forth.

Filename - The name of a file on a disk. Example: PCMICAR.EXE is made up
of the filename PCMICAR and extension .EXE.

Hotkey - A key or pair of keys that can be pressed to access a menu function
directly, without going through the menu system. For example,
pressing the F2 key will access the Open a File menu option.

Import - To read data from a formatted file and place it in a PC-MICAR
certificate database. 
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Menu - A list from which to select an action that PC-MICAR can perform.
PC-MICAR has both a main menu and submenus. The main menu
appears as a bar across the top of the screen, just below the
program name. From the main menu, a submenu can be selected
listing actions to be performed. See the section Using the PC-
MICAR Menu System (pg. 16) for more details on how to use the
menu.

Pick List - A list of items that can be selected (picked) by using the up and
down arrow keys to highlight the desired item and then pressing
{ENTER}.

Subdirectory - See Directory above.

Submenu - A group of related actions arranged into a list from which an action
can be selected. Submenus are available through the main menu.
See the section Using the PC-MICAR Menu System (pg. 16) for
more information on the menu system.

Table - A subdirectory on the computer where PC-MICAR processing
Directory files are stored. By default, the table directory is a subdirectory of

the <PCMICAR> directory called <TABLES>. The default value
can be changed through PC-MICAR.
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APPENDIX D - CONVENTIONS USED IN THIS MANUAL

The conventions used in this manual are the same as for the PC-MICAR User’s Manual.
They are repeated here for convenience.

1. All of the actual typing and keys that need to be pressed will be given in all-caps
(Example: type DIR and press {ENTER} to get a list of files in a directory).

2. Any information that the user needs to provide, such as filenames, will be
requested in brackets (Example: type [filename.ext] means that the user needs to
type in the filename and its extension, like so: type WY91001.DBF, without the
brackets.)

3. When the word "press" appears in front of a word in all-caps, the user needs to
press and release a particular key (Example: press {ESC} means press and release
the ESC key). Also, the names of all keys will be given in braces {}.

4. Whenever two keys are named with a hyphen ( - ) connecting them, both keys are
to be pressed at the same time to perform the listed function (Example:
{CTRL-ENTER} = press and hold the {CTRL} and {ENTER} keys at the same
time).

5. At times, references will be made to other Menu Options or Functions of
PC-MICAR. The following standards will be used in these cases:

A. Any selection from the Main Menu (the menu that runs across the top of the
PC-MICAR screen, just below the title) will be called a Menu Option
(Example: the File Menu Option).

B. Any selection from a submenu will be called a menu Function or just Function
(Example: the Edit/Browse Certificates Function).

6. All directory names will be marked by greater than and less than symbols
(Example: The directory containing the PC-MICAR programs is the <PCMICAR>
directory).
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APPENDIX E - ACCESSING THE UNIVERSAL PROMPT DEMO

PC-MICAR incorporates the new universal external cause prompts. The prompts are
designed to capture information needed by ICD-10 to code external causes, while losing
none of the required data for ICD-9. To help users familiarize themselves with the new
prompts, a demonstration package has been provided. This package displays a number of
injury descriptions, along with the place of injury, and allows the user to select the
corresponding prompt via the external cause prompt system. Three attempts are allowed
for each record. The number of tries required to get a correct prompt is displayed at the
bottom of the screen.

To access the external cause prompt demonstration package, follow these steps:

1. From the DOS prompt, change to the <PCMICAR> directory. This can be
accomplished by entering the following command at the DOS prompt:

CD \PCMICAR

2. At the DOS prompt, type the command PROMPT10 and press <ENTER>.

3. The first record will be displayed. Continue to select prompts from the screen.
After each record is completed, a message will ask if the user wishes to continue.
Select YES to go on to the next record. Select NO to exit the prompt demo.

4. When the prompt demo package is restarted, it can be run from the beginning or
from the point where the last user exited.
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APPENDIX F - ACCESSING THE PC-MICAR 1996 DEMO

Because PC-MICAR 1996 is very different from prior versions, a demonstration package
has been provided that outlines the changes in the screens, the menu system, the external
cause prompts, and the data files. Users should go through this demo to familiarize
themselves with aspects of this new software. It should take 10 to 15 minutes to complete
the demo.

To access the PC-MICAR 1996 demo, follow these steps.

1. From the DOS prompt, change to the <PCMICAR> directory. This can be
accomplished by entering the following command at the DOS prompt:

CD \PCMICAR

2. At the DOS prompt, type the command PCMDEMO and press <ENTER>.

3. A series of screens containing information will be displayed. Press <ENTER> after
reading each screen to go on to the next one. When the demo is complete, the
DOS prompt will once again be displayed.
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APPENDIX G - CONVERTING FILES

For those who implemented the October 1995 version of PC-MICAR 1996, this section
outlines how to convert files created with that system to a format usable by the second
release of PC-MICAR 1996. The new database format is much more compact than the
previous one. As a result, converting the files could save significant hard drive space.
Files must be converted before they can be used with this version of PC-MICAR 1996.

To convert a data file, follow these steps.

1. From the DOS prompt, change to the <DATA> directory using the following
command:

CD directory

Where directory is the full path name of the directory where data files are stored.

2. Run the conversion program from the DOS prompt by typing:

PCM96CVT <ENTER>

3. A file selection window is displayed showing all the database files in the data
directory. Use the up and down arrow keys to highlight the name of the file to be
converted. When the file name is highlighted, press <ENTER>.

4. The file will be converted. The old file will be stored as a database file. Its name
will be the same as the name that it had before, with the letter O appended to the
end of the file name. For example, the backup for a file named TEST.DBF would
be TESTO.DBF. Once it is confirmed that the conversion was successful, the old
file can be deleted to make more space on your hard drive.

5. Repeat steps 2 through 4 to convert other files.
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